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ABSTRACT 

Schager, Sara, Masters of Environmental Assessment, Using cloud-based remote sensing to estimate 

Hurricane Impacts on Vegetative Cover in Carolina Bays in North Carolina 

Carolina Bays are unique geographically isolated wetlands that provide critical habitat to several 

species of plants and animals in the southeastern United States.  These areas, due to their inland 

location, unique vegetation, and shallow inundation of water, can experience strong effects 

from hurricanes.  Hurricanes’ high winds, and large amounts of precipitation could affect these 

shallow, inland wetlands.  Carolina Bays have not been well studied, and the impacts of 

hurricanes on them have been even less evaluated.  I utilized a cloud-based remote sensing 

approach to examine the effects of hurricanes on the vegetative cover of Carolina Bays.  Using 

Climate engine, I utilized the normalized difference vegetation index (NDVI) as a measure of 

vegetation status. I evaluated seven hurricanes and 32 sites to determine if hurricanes affected 

vegetative cover in Carolina Bays.  Out of the 32 sites and seven hurricanes examined, five sites 

showed statistically significant effects to vegetation from hurricanes. Site 6 had a higher NDVI 

value (0.909) before the hurricane than it did during the same time period the year after the 

hurricane occurred (0.755). Additionally, Site 6 was 60% agricultural field.  This site showed that 

Climate Engine is capable of detecting changes in NDVI values on Carolina Bay sites.  Four sites 

affected by Hurricane Fran had a significantly lower NDVI the month after the hurricane 

occurred than they did the month before the hurricane.  Hurricane Fran was a larger hurricane 

event and probably had bigger vegetative impacts than the smaller hurricane events.  My 

research suggests that NDVI values obtained from Climate Engine are capable of determining 

vegetative impacts on Carolina Bays, especially changes to NDVI of Carolina Bays during bigger 

hurricanes. While Climate Engine makes large amounts of remote sensing data easily accessible, 

in our case the remote sensed data did not show very strong impacts of smaller hurricane 

events on Carolina Bays. This is probably due to the fact that the actual impacts on the ground 

are limited due to the dynamic nature of the Carolina Bays themselves, rather than limitations 

of Climate Engine. Limitations such as cloud cover during evaluation windows, resolution of 

satellite photography (30 x 30 m pixels), and the fact that NDVI cannot pick up on species 

composition changes or changes caused by fallen debris may have hindered evaluation.  Future 

research on Carolina Bays should focus on changes in depth of water due to precipitation and 

fallen debris, which may uncover additional impacts to these ecosystems from hurricanes.   
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Introduction 

Carolina Bays are a unique habitat type that occur in the Coastal Plain area of the southeastern 

United States.  They are small elliptical wetlands that are arranged in the landscape from a northwest to 

southeast direction (Prouty, 1952).  These depressions are oriented from northwest to southeast and 

are not connected to other wetlands (Linde et. al., 1995).  Carolina Bays also incorporate a sand rim on 

the southeastern edge (Prouty, 1952).  They receive most of their water input from precipitation in the 

spring and fall and also tend to dry out during the summer months (South Carolina Department of 

Natural Resources, 2015).  Currently there are estimated to be between 10,000 and 20,000 Carolina 

Bays in existence (Richardson and Gibbons, 1993), with many areas that were historically Carolina Bays 

drained for agricultural uses.      

 There have been several theories about how Carolina Bays formed.  However, recent research 

has pointed toward Carolina Bays being the remains of glacier ice boulders which were thrown off a 

meteorite.  This created seismic shock waves which when they impacted the Earth created liquified 

ground that was subsequently impacted by pieces of ice from the boulders.  The meteorite is believed to 

have impacted the Laurentide Ice Sheet (Zamora, 2017).  The orientation of these wetlands in a 

northwestern to southeastern direction was caused by this single impact event (Zamora, 2017).   

Carolina Bays provide a unique habitat for vegetation that is not seen in other habitats.  They 

have a fluctuating hydrologic regime that responds to rainfall seasonality (Sharitz and Gibbons, 1982 and 

Schalles and Shure 1989). Carolina Bays have a larger species richness in their seed banks than has been 

noted in other types of wetlands (Kirkman, 1996).  Additionally, they are a habitat for several rare 

herbaceous flowering plants (Bennett and Nelson, 1990 and Knox and Sharitz, 1990).  Finally, Carolina 

Bays are important to overall water quality and carbon sequestration (Sullivan et. al., 2017). This set of 

unique characteristics makes them a valuable part of the landscape.   

Wetlands, in general, perform important functions by exchanging materials and energy with the 

surrounding environment (Cohen et. al., 2015).  They fulfill necessary functions such as providing vital 

habitat for dependent organisms, acting as retention areas for sediment and nutrients, and reducing the 

severity of flooding events downstream of their location. (Cohen et. al., 2015).  Carolina Bays are 

important because they offer critical habitat to rare plants and animals. Research on Carolina Bays has 

largely focused on how they were formed, their hydrologic impacts, and on the unique plants and 

animals that utilize them.  However, vegetative impacts to Carolina Bays from hurricanes have not been 
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well studied.  Hurricanes, with high winds and large amount of rainfall that occur, could easily impact 

Carolina Bays by creating changes in vegetative cover within the Carolina Bay itself and the surrounding 

area.   

Hurricanes produce two main types of impacts on wetlands, wind effects and precipitation 

effects.  Wind effects include wind damage to trees and vegetation.  Hurricanes can also impact Carolina 

Bays by changing hydroperiod and impacting vulnerable plant and animal habitat (by increasing forest 

floor litter near geographically isolated wetlands, thereby increasing suitable habitat).   

Research on hurricanes has shown than they have a largely varied path after landfall.  Previous 

research has studied the width of the storm path, the effects of the storm, what happens to coastal 

habitats because of them and even the flooding events they cause (Doyle 2009, Avery et.al., 2014, 

Rodgers et. al., 2009 and Conner et. al., 2014).  A map created by the National Oceanic and Atmospheric 

Administration (NOAA) provides the paths of all the recorded hurricanes that have impacted the 

southeastern United States. Additionally, Bianchette (Liu et. al., 2016) found that hurricane Isaac (a 

landfalling hurricane) had the biggest impacts 70 km to the east of the exact storm path.  Due to the 

general rotational direction of hurricane winds, 70 km to the east of the actual hurricane’s path would 

conceivably receive the most severe impacts. Hurricane winds are one of the forces that expose 

wetlands to damage in numerous ways.  The main impact to wetlands from hurricane winds is wind 

damage to vegetation.  A study of wetlands in Virginia found that tree damage caused by high winds 

increased with increasing soil salinity and proximity to the Atlantic Coast (Middleton, 2016). 

In addition to the impacts discussed above, it is important to note that inland geographically 

isolated wetlands (GIW’s), such as Carolina Bays, may be more sensitive to hurricanes than coastal 

wetlands, because they do not experience hurricanes on a regular basis and thus might not be adapted 

to deal with high winds and rainfall.  A study in 2016 found that the impact on vegetation from 

hurricanes can be extremely variable, however, in general, saltwater wetlands are more resilient than 

freshwater wetlands (Medeiros et al. 2016). This suggests that inland GIW’s may experience different 

effects than coastal wetlands due to the lack of storm surge, but may experience other impacts such as 

vegetative damage due to hurricane winds (Medeiros et al. 2016).   

Remote sensing has been used to determine human impacts of hurricanes in populated areas 

(Kelmas, 2009), but not specific to wetlands or Carolina Bays.  Additionally, researchers found that a 

canopy foliage index (CFI), which was created by transforming satellite optical data,  showed a large 
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decrease in canopy cover following a storm event for a wetland area in southern Louisiana following 

Hurricane Katrina (Ramsey et al. 2009).  Additionally, Rodgers et. al. 2009, found  declines of up to 49% 

on the normalized difference vegetation index (NDVI) on coastal emergent wetlands impacted by 

Hurricane Katrina using Landsat 5 satellite images before and after the hurricane to determine impacts.  

However, to my knowledge no work has been done on using remote sensing to estimate the impacts of 

hurricanes on the vegetation of Carolina Bays.     

In this study, I used the NOAA Hurricane Paths Map to identify hurricanes that might have 

impacted Carolina bays. I used Landsat images to estimate the Normalized Difference Vegetation Indices 

(NDVI) to determine if hurricanes had notable vegetative impacts on Carolina Bays.   I obtained the 

Landsat images from Climate Engine (http://clim-engine.appspot.com/).  Climate Engine is an online 

cloud-based tool that utilizes Google Earth and Google Cloud to allow satellite and climate data to be 

processed for research purposes (Huntington et al. 2017).  Climate Engine makes freely available all  

Landsat images and can be used to download timeseries of NDVI indices for a particular area using a 

point and click interface.  Climate Engine has the potential to serve as a valuable tool for natural 

resource managers, given the large amount of climate and remote sensing data that has now become 

freely accessible (Huntington et al. 2017). The NDVI is an index that measures vegetative cover using 

satellite imagery.  NDVI values range between 0 and 1 and the higher the indices, the more green 

vegetative cover the satellite imagery observed at the given date.    

 Our ability to study the impacts of hurricanes may become increasingly important as climate 

change could increase the frequency of hurricanes that make landfall in North Carolina and expose 

Carolina Bays to high wind and precipitation events. 

 

Methods 

In order to examine the impacts of hurricanes on Carolina Bay vegetation, I generated maps of 

seven hurricanes that made landfall in North Carolina between 1996 and 2015 by downloading the 

information from the National Oceanic and Atmospheric Administration (NOAA, 

https://coast.noaa.gov/hurricanes/).  The NOAA Historical Hurricanes Tracks web tool was used to 

determine where each of the studied hurricanes impacted North Carolina.  The coordinates for each 

http://clim-engine.appspot.com/
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hurricane path were then downloaded into ArcMAP.  Map 1 shows the ArcMAP image of the hurricane 

paths that were used to select study sites in this project. 

 

Map 1. Paths of Seven Study Hurricanes Impacting North Carolina in the years 1996-2015.  

 

Hurricanes with different wind speeds and strengths were studied to see if the strength of the 

hurricane impacted the vegetation differently.  I created buffers around each of the hurricane paths at 

30 km to the west, 30 km to the east, 70 km to the east and 100 km to the east (see the ArcMAP 

Procedure Log from Appendix B for details). These distances were chosen to evaluate impacts of 
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hurricanes on Carolina Bays because they give an even distribution of impacts from the actual path of 

the hurricane.  Maps 2-8 show the buffer zones for each hurricane.    
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Map 2.  Hurricane Alberto Buffers

 



12 
 
 

Map 3.  Hurricane Andrea Buffers
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Map 4.  Hurricane Ana Buffers 
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Map 5.  Hurricane Beryl Buffers 
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Map 6.  Hurricane Ernesto Buffers
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Map 7.  Hurricane Hanna Buffers 
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Map 8.  Hurricane Fran Buffers 
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Next, a map of Carolina Bays in North Carolina (http://georgehoward.net/NCBays.KMZ) was 

overlaid on the buffered hurricane path map and five Carolina Bay sites were selected for each 

hurricane (30 km west of the hurricane path, the hurricane path, 30 km east of the hurricane path, 70 

km east of the hurricane path and 100 km east of the hurricane path).  The Carolina Bay’s GIS file was 

verified and Carolina Bay study sites were determined to have the appropriate size and orientation using 

this map and satellite imagery.   Map 9 shows the buffered hurricane path for Hurricane Fran, along with 

the selected sites for this hurricane.   

Map 10 shows a close up image of the Carolina Bay map layer and the satellite imagery to show 

how a site was selected.  In general, the Carolina Bays selected had to be located correctly, and be 

covered in vegetation (this was determined by overlaying satellite imagery provided in ArcMAP onto the 

map of hurricane paths and Carolina Bay locations).  However, as controls, one site was selected that 

was suburban and one that showed standing water.  These two sites were selected to determine if any 

observed changes to the NDVI were occurring on these sites, indicating a different cause than hurricane 

damage.   

Map 11 shows the same study site without the Carolina Bay map layer to exhibit how by 

zooming to a closer view, I was able to select sites that were exactly on Carolina Bay sites.  Map 12-18 

show the selected study sites for the studied hurricanes.      

http://georgehoward.net/NCBays.KMZ
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Map 9.  Hurricane Fran Path Buffers and Study Sites.
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Map 10.  Hurricane Alberto Study Site #3 Close Up
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Map 11.  Hurricane Alberto Study Site #3 Close Up Polygons Removed
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Map 12.   Hurricane Alberto Study Sites
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Map 13.  Hurricane Andrea Study Sites
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Map 14.  Hurricane Ana Study Sites
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Map 15.  Hurricane Beryl Study Sites
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Map 16.  Hurricane Ernesto Study Sites
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Map 17.  Hurricane Hanna Study Sites
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Map 18.  Hurricane Fran Study Sites
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Next, the latitude and longitude were determined for each study site.  This was done by going 

into the ArcMap program, selecting the study site with the identify feature, and clicking on each Carolina 

Bay study site.  This brought up a table that identifies information about the site selected (the study 

site).  On this table is a location tab.  Clicking on the button to the right of this information provides 

coordinates in Degrees Decimal Minutes.  (See Appendix B for GIS Procedure Log).  The output is then 

the latitude and longitude information for that study site.  This information is one of the pieces of data 

entered into Climate Engine.   

Climate Engine (http://clim-engine-development.appspot.com/) was then used to obtain time 

series of NDVI data about each site selected.  Once the Climate Engine site is opened, I selected the 

“Make Graph” tab at the top left of the page.  Table 1 shows the variables selected for each site to 

obtain the NDVI data for that study site within the Climate Engine website.   

After the proper variables were selected, I chose the Get Time Series Button.  The data range for 

each site was selected from 13 months before the hurricane impacted the study site to 13 months after 

the hurricane impacted the site, so that I could compare NDVI numbers from before the hurricane hit 

the study site, to after the hurricane hit the study site.  This created a time series of NDVI for each site.  

Figure 1 shows the graph for Site 1.  See Appendix C for each study sites’ NDVI graph.   

 

 

 

 

 

 

 

 

 

 

http://clim-engine-development.appspot.com/
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Table 1. Variables selected to obtain time series NDVI values for the study sites from the Climate Engine 

online tool (https://clim-engine.appspot.com/). 

Region  Point (input latitude and longitude site data into 
drop down menu) 

Time Series Calculation Drop Down Menu  #1 Daily Data 

Time Series Calculation Drop Down Menu #2 One Variable Analysis 

Variable #1 Type Remote Sensing 

Variable #1 Dataset Landsat 4/5/7/8 Surface Reflectance 

Variable #1 Variable NDVI (Vegetation Index) 

Variable #1 Computation Resolution (Scale) 30 < 

Time Period Season  Custom Date Range 

Time Period State Date Enter date that is 1 year and 3 months before the 
hurricane  

Time period End Date Enter date that is 1 year and 9 months after the 
hurricane 
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Figure 1.  NDVI graph for study site 1, Hurricane Alberto:  June 13, 2006. 

 

 

 These graphs were then used to to obtain NDVI numbers for 13 months before the hurricane 

impacted the study site, 11 months before the hurricane impacted the study site, 1 month before the 

hurricane impacted the study site, 1 month after the hurricane impacted the study site, 11 months after 

the hurricane impacted the study site and 13 months after the hurricane impacted the study site.  This 

time frame was chosen because it allowed me to compare NDVI numbers from the same time of year 
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both before and after a hurricane had impacted the study site.  This allowed me to account for any 

seasonal changes in the NDVI that might occur and compare like times of year in our analysis.   

 Statistics were then obtained from the NDVI numbers using SAS Enterprise Guide software and 

SAS JMP software.  A Distribution Analysis was run on the data to compare NDVI numbers for each 

hurricane.  Average and one standard deviation were calculated for each study site.  Finally, JMP 

software was utilized to run ANOVA’s which determined differences across the means of the NDVI 

numbers, and Tukey’s Post hoc tests which were performed to show which of the tested means were 

statistically different. 

 

Results 

Thirty two study sites were evaluated to determine changes to NDVI numbers in Carolina Bays 

associated with seven hurricanes.  

Hurricane Alberto (NOAA Storm Number 2006161N20275) impacted North Carolina on June 13, 

2006.  It was a Tropical Depression over South Carolina earlier that day but was losing strength as it 

proceeded over North Carolina.  I evaluated five study sites from Hurricane Alberto (Sites 1-5).  Table 19 

in Appendix D shows the site information for Sites 1-5.   

Hurricane Andrea (NOAA Storm Number 2013157N25273) impacted North Carolina on June 7, 

2013.  It also was a Tropical Depression over South Carolina earlier that day but was losing strength as it 

proceeded over North Carolina.  I evaluated five study sites from Hurricane Andrea (Sites 6-10).  Table 

20 in Appendix D shows the site information for Sites 6-10.  

Hurricane Ana (NOAA Storm Number 2015126N27281) impacted North Carolina on May 10, 

2015.  It was a Tropical Storm when it made landfall on the South Carolina coast.  As it proceeded inland 

over North Carolina it began to weaken and impacted North Carolina as a Tropical Depression.  I 

evaluated five study sites from Hurricane Ana (Sites 11-15).  Table 21 in Appendix D shows the site 

information for Sites 11-15.    

Hurricane Beryl (NOAA Storm Number 2012147N30284) impacted North Carolina on May 30, 

2012 as a Tropical Storm.  Due to the path that Hurricane Beryl took (it was so close to the North 

Carolina coast), the sites to the right of the hurricane were located in the ocean and had no Carolina 
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Bays to select as study sites.  Therefore only two study sites were evaluated from Hurricane Beryl (Sites 

16 and 17).  Table 22 in Appendix D shows the site information for Sites 16 and 17. 

Hurricane Ernesto (NOAA Storm Number 2006237N13298) impacted the North Carolina on 

September 1, 2006 as a Tropical Storm.  It weakened to a Tropical Depression near Raleigh, NC as it 

proceeded through the state.  I evaluated five study sites associated with Hurricane Ernesto (Sites 18-

22).  Site 22 is an aquatic Carolina Bay, rather than a vegetated site, that was utilized as a type of control 

to make sure the Climate Engine Data was collected and evaluated correctly.  Table 23 in Appendix D 

shows the site information for Sites 18-22. 

 Hurricane Hanna (NOAA Storm Number 2008241N19303) impacted North Carolina on 

September 6, 2008 as a Tropical Storm.  I evaluated five study sites associated with Hurricane Hanna 

(Sites 23-27).  Site 24 is a suburban Carolina Bay, rather than vegetated site.  It shows up as Carolina Bay 

site on the satellite photography (the characteristic elliptical shape can be seen), however, on closer 

examination it can be seen that the sites is currently in a housing development with suburban 

vegetation such as lawn and yard.  This site was also used as a control site to see if changes in the NDVI 

numbers that may be noticed were due to season rather than hurricane wind impacts.  Table 24 in 

Appendix D shows the site information for Sites 23-27.   

 Hurricane Fran (NOAA Storm Number 1996237N14339) impacted North Carolina on September 

6, 1996 as a Category 3 storm.  As it moved through North Carolina, it weakened to a Category 1 storm  

over Fayetteville.  I evaluated five study sites associated with Hurricane Fran (Site 28-32).  Table 25 in 

Appendix D shows the site information for Sites 28-32.    

 The NDVI numbers for each study site were obtained for 13 months before the hurricane, 11 

months before the hurricane, 1 month before the hurricane, 1 month after the hurricane, 11 months 

after the hurricane and 13 months after the hurricane. .  This allowed for changes due to time of 

year/seasonal changes in vegetative cover to be negated.  It allowed me to focus on any changes that 

occured only because of the hurricane’s impacts.   
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Table 3.  Summary statistics of study sites for Hurricane Alberto during specific time periods 

 13 
months 
before 
the 
hurricane 

11 months 
before the 
hurricane 

1 month 
before the 
hurricane 

1 month after 
the hurricane 

11 months 
after the 
hurricane 

13 months 
after the 
hurricane 

Mean 0.78635 0.7287 0.83525 0.785125 0.761425 0.73655 

Standard 
Deviation 

0.02643 0.18185 0.02678 0.78275 0.04372 0.059 

Median 0.7832 0.81215 0.8245 0.02218 0.7704 0.7495 

Variance 0.000699 0.03307 0.000717 0.000492 0.00951 0.00348 

 

 

Table 4.  Summary statistics of study sites for Hurricane Ana during specific time periods 

 13 months 
before the 
hurricane 

11 months 
before the 
hurricane 

1 month 
before the 
hurricane 

1 month 
after the 
hurricane 

11 months 
after the 
hurricane 

13 months 
after the 
hurricane 

Mean 0.7203 0.8401 0.77395 0.83934 0.755 0.8525 

Standard 
Deviation 

0.06389 0.04018 0.10956 0.05314 0.887 0.895 

Median 0.6925 0.85 0.81825 0.865 0.725 0.8587 

Variance 0.00408 0.00161 0.012 0.00282 0.892 0.79 
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Table 5.  Summary statistics of study sites for Hurricane Andrea during specific time periods 

 13 months 

before the 

hurricane 

11 months 

before the 

hurricane 

1 month 

before the 

hurricane 

1 month after 

the hurricane 

11 months 

after the 

hurricane 

13 months 

after the 

hurricane 

Mean 0.8097 0.74828 0.81326 0.655 0.8173 0.755457 

Standard 

Deviation 

0.0555652 0.023838 0.06964248 0.042713441 0.067394 0.056432 

Median 0.7925 0.8 0.795 0.775 0.7955 0.729 

Variance 0.1348066 0.280132 0.15129671 0.186725613 0.169904 0.003725 

 

 

Table 6.   Summary statistics of study sites for Hurricane Beryl during specific time periods 

 13 months 

before the 

hurricane 

11 months 

before the 

hurricane 

1 month 

before the 

hurricane 

1 month 

after the 

hurricane 

11 months 

after the 

hurricane 

13 months 

after the 

hurricane 

Mean 0.6275 0.60215 0.64125 0.687 0.6725 0.7003 

Standard 

Deviation 

0.05303 0.03981 0.06541 0.08202 0.08556 0.10932 

Median 0.6275 0.60215 0.64125 0.687 0.6725 0.7003 

Variance 0.00281 0.00158 0.00428 0.00673 0.00732 0.01195 
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Table 7.    Summary statistics of study sites for Hurricane Ernesto during specific time periods 

 13 months 
before the 
hurricane 

11 
months 
before 
the 
hurricane 

1 month 
before the 
hurricane 

1 month after 
the hurricane 

11 months 
after the 
hurricane 

13 months after 
the hurricane 

Mean 0.62926 0.62276 0.67064 0.57524 0.63578 0.5505 

Standard 
Deviation 

0.38897 0.43212 0.32656 0.43338 0.36716 0.52927 

Median 0.7925 0.8 0.795 0.775 0.7955 0.729 

Variance 0.1513 0.18673 0.10664 0.18782 0.13481 0.28013 

 

 

Table 8.    Summary statistics of study sites for Hurricane Hanna during specific time periods 

 13 months 
before the 
hurricane 

11 months 
before the 
hurricane 

1 month 
before the 
hurricane 

1 month 
after the 
hurricane 

11 months 
after the 
hurricane 

13 months 
after the 
hurricane 

Mean 0.70942 0.67724 0.70528 0.64966 0.72016 0.67754 

Standard 
Deviation 

0.23261 0.22759 0.21474 0.23567 0.22231 0.23977 

Median 0.826 0.76 0.7983 0.7345 0.8325 0.772 

Variance 0.05411 0.0518 0.04611 0.05554 0.04942 0.05749 
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Table 9.  Summary statistics of study sites for Hurricane Fran during specific time periods 

 13 months 
before the 
hurricane 

11 months 
before the 
hurricane 

1 month 
before the 
hurricane 

1 month 
after the 
hurricane 

11 months 
after the 
hurricane 

13 months 
after the 
hurricane 

Mean 0.729 0.6455 0.7084 0.58364 0.7217 0.7063 

Standard 

Deviation 

0.08044 0.1539 0.04736 0.08933 0.06897 0.06668 

Median 0.7675 0.735 0.725 0.5832 0.755 0.72 

Variance 0.00647 0.02369 0.00224 0.00798 0.00476 0.00445 

 

Tables 3-9 show the statistical summaries of of all sites NDVI values separated by when the NDVI 

measurement was taken in relation to when the hurricane occurred.  These statistics were used to 

create Figure 2.  Values ranged from 0.65 to 0.85, except for the site that contained standing water (site 

22, which had an average NDVI value of -0.15) and the site that contained a housing development (site 

24, which had and NDVI value of 0.25, Figure 2).  Figure 2 shows the average NDVI number for each 

study site.  Checking satellite imagery in ARCMAP revealed that approximately 60 % of Site 6 is an 

agricultural field.  Additionally, Sites 28-32 are Hurricane Fran study sites.   
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Figure 2.  Average NDVI number for each Study Site.  

 

Next, utilizing SAS’s JMP software an ANOVA was run to determine differences across the means 

for the study sites.  Following the ANOVA, Tukey’s Post Hoc test was run to determine the which of the 

study sites means were statistically different from the average.  Site 6 and 4 of the 5 Hurricane Fran 

study sites (Sites 28-30 and 32) has statistically significant different means than the average.  We 

created a figure that shows the results for Site 6’s mean NDVI value before and after the growing season 

in years with and without a hurricane (Figure 3).    
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Figure 3. Hurricane Andrea Site 6 Mean NDVI Before and After the Growing Season in years with 

and without a hurricane. 

 

Finally, we created a figure that showed the results for Hurricane Fran’s sites (Sites 28-32).  NDVI 

numbers differed significantly before and after the hurricane the year the hurricane occurred, when 

compared to the years without a hurricane (Figure 4).  
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Figure 4.  ANOVA Results for the NDVI Numbers for study sites from Hurricane Fran (Sites 28-32 

combined) one month before and after Hurricane Fran, the year before Hurricane Fran,  the year of 

Hurricane Fran  and the year after Hurricane Fran. 

 

 

Hurricane Fran’s study sites and study site 6 were the only sites that showed significant 

differences in the NDVI values before and after the hurricane event.  

 

Discussion 

 Statistically significant changes to Carolina Bay’s vegetation were detected using the NDVI data 

available on Climate Engine in study site 6, 28, 29, 30 and 32.  The sites that showed statistically 

significant lower values of NDVI after the hurricane were Site 6 (Hurricane Andrea, 30km to the left of 

the hurricane path) and Sites 28, 29, 30, and 32 (Hurricane Fran sites).   
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Site 6 is located 30 km to left of the path of Hurricane Andrea.  Hurricane Andrea hit South 

Carolina as a Tropical Depression and continued to weaken as it moved over North Carolina. The NDVI 

graph is shown in Figure 4..  The hurricane event occurred on June 7, 2013. 

Site 6 showed a change in the NDVI value between one month before the hurricane event and 

one month after the hurricane event.  Looking at the NDVI graph (Figure 6), it can be seen that there is a 

difference between the NDVI one month before the hurricane event and the NDVI one month after the 

hurricane event.  However, examining satellite imagery from ARCMAP (Map 19) shows, study site 6 is 

partly covered in an agricultural field.  The seasonal trend in the changing NDVI number therefore is 

occurring in response to the agricultural use of the field rather than an impact from a hurricane event.     

For study site 6, seasonal changes in the NDVI value would be expected due to crop planting and harvest 

cycle harvest. Even though this entire site is not an agricultural field, enough of it is that we would 

expect to see a change in the NDVI value that would not be observed in the other Carolina Bay sites. This 

site  served as a control in relation to the fact that the Climate Engine tool is capable of detecting 

changes in the vegetative cover of Carolina Bay sites.  This allowed us to show in our study that Carolina 

Bays are not being significantly impacted by changes in vegetative cover unless the hurricane event is a 

large one.  Site 6 and the changes in its NDVI numbers allowed us to understand that the Climate Engine 

tool is an effective tool for observing changes in vegetative cover on Carolina Bays.  However, these 

vegetative cover changes are not occurring during the smaller hurricane events.   

Looking at Site 28-30 and 32 (Hurricane Fran study sites) it can be further determined that there 

are statistically significant changes to the amount of vegetative cover in Carolina Bays when larger 

hurricanes pass over them, but not when smaller storm events occur.     
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Map 19. Study Site 6.
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Figure 6:  Timeseries of NDVI for site 6. 
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Sites 28-30 and 32 showed a decrease in the NDVI the month after the hurricane occurred when 

compared to the month before (Site 28 NDVI before the hurricane 0.635 and after the hurricane 0.5875, 

Site 29 NDVI before the hurricane 0.808 and after 0.735, Site 30 NDVI before the hurricane 0.7675 and 

after 0.7425, and Site 32 0.65 and 0.4).  These changes do not take into account seasonal changes and 

Hurricane Fran occurred in September, meaning possible changes could be due to the end of the 

growing season.   

These changes are not long term as recovery of the vegetative cover was observed the following 

year for the impacted sites. Additionally, Hurricane Fran was the largest and most powerful of the 

studied hurricanes, suggesting that impacts occurred to Carolina Bays from the stronger hurricanes.  

However, the fact that the impacts do not appear long term suggests that Carolina Bays may be resilient 

to the impacts from hurricanes due to the seasonal nature of the hydrologic impacts they are 

accustomed to encountering.  

The distance of the study site from the actual hurricane path did not impact the NDVI.   Study 

sites 30 kilometers left of the hurricane path, in the direct line of the hurricane path, 30 kilometers to 

the right of the hurricane path, 70 kilometers to the right of the hurricane path and 100 kilometers to 

the right of the hurricane path all showed the same result when their NDVI numbers were examined.  

They were not statistically significantly different before the hurricane when compared to after the 

hurricane event.   

Alternatively, the size of the hurricane event did impact the NDVI for the study sites.   Impacts 

from small hurricane/ tropical storms are not observable by examining an NDVI number for the site 

impacted.   However, the vegetative impacts to the larger Hurricane Fran were observable in the NDVI 

numbers.  This would suggest that vegetative impacts to Carolina Bays are observable using the NDVI as 

an assessment tool.  However, the possible smaller impacts from small hurricanes/tropical storms are 

not detectable using NDVI.   

One of the reasons that Climate Engine may not be able to detect vegetative impacts from the 

hurricanes on the NDVI are that the hurricanes studied (except for Hurricane Fran) were not large 

enough at the time they passed over the study sites.  All the other hurricanes were studied were 

Tropical Storm force winds or lower (See Table 1.)  With these smaller hurricanes impacts to vegetation 

may be non-existent.  It maybe that only larger hurricanes like Fran are having actual vegetation impacts 
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on Carolina Bays. This is supported by the fact that when changes are known to have occurred, as in 

study site 6, Climate Engine detected these changes and they were reflected in the NDVI numbers. 

Table 18 shows the data, including lowest observed pressure, maximum recorded winds and the 

strength of each hurricane as it made landfall in North Carolina for the hurricanes associated with the 

study sites evaluated.  Additionally, rainfall totals are shown in Table 18.  Table 18.  Hurricane Data Table 

Hurricane 

Name 

Dates of 

Hurricane  

Lowest 

Observed 

Pressure 

Maximum 

Winds (kts) 

North Carolina 

Landfall Status 

Rainfall 

Amount 

Alberto 5/19-5/23 2012 995.0 50 kts <Tropical 

Depression 

5.64 inches at 

RDU airport 

Andrea 6/5-6/8 2013 992.0 55 kts <Tropical 

Depression 

5.14 inches at 

RDU airport 

Ana 5/6-5/12 2015 998.0 50 kts Tropical 

Depression 

5.13 inches at 

Leland, NC 

Beryl 5/25-6/2 2012 992.0 60 kts Tropical Storm 6.00 inches at 

Hyde County, 

NC   

Ernesto 8/24-9/4 2006 985.0 60 kts Tropical Storm 9.85 inches at 

Grifton, NC 

Hanna 8/28-9/8 2008 977.0 70 kts Tropical Storm 1.11 inches at 

Newport, NC 

Fran 8/31-9/6 1996 946.0 105 kts Category 3 8.80 inches at 

RDU airport 

 

The main other study that was able to use NDVI to look at hurricane effects on wetlands was 

Rodgers et. al. 2009, who found a 49% decrease in the NDVI value between March (before the hurricane 
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Katrina hit) and September (after the hurricane hit) 2005.  Although this study evaluated coastal 

wetlands and changes in the NDVI were attributed to increased salinity at the site, it led us to wonder if 

NDVI was a good method for examining changes to Carolina Bays due to hurricanes.   

 Carolina Bays are wetland areas that have adapted to seasonal changes in moisture and 

inundation levels.  They host plant and animal life that are adapted to this transition.  It makes sense 

that the types of vegetation that utilize Carolina Bays are also adapted to thrive in environments where 

change is constant and periods of severe weather are present.   

As for the impacts of hurricanes on Carolina Bays, even when these impacts are observed, they 

appear to not be long term changes.  This suggests that Carolina Bays are dynamic ecosystems that have 

evolved to tolerate changes to their environment and are often in an state of change.  This idea is 

reinforced by what is known about Carolina Bays.  They are environments that experience seasonal 

changes in their hydrologic cycle.  The plants that exist in Carolina Bays are used to varying periods of 

water inundation.  Therefore, the impacts of large amounts of precipitation may not be impacting 

Carolina Bay’s vegetation like it would in a wetland that did not normally experience these changes in 

water levels.   

Future studies should examine how vegetative species composition might change in response to 

hurricanes.  The type of damage caused by hurricanes on Carolina Bays may be hard to detect using 

remote sensing because vegetation is mostly bushes, sedges and grasses.  NDVI measures vegetative 

cover, and when bushes, sedges and grass are blown around by hurricanes the NDVI number may not be 

impacted because vegetation is still present in the Carolina Bay.  The wind may injure these types of 

vegetation, but not remove them.  This could be an avenue for species better adapted to disturbances 

to move into Carolina Bays, out competing species that do not favor disturbances.   

The satellite data may not be able to distinguish changes in species compositions due to 

hurricanes.  For example, hurricanes have been shown in some studies to change the species 

composition in wetlands.  Wind damage to wetlands during hurricanes was observed as a major cause of 

the damage to two wetland study sites on the Delmarva Peninsula (Middleton, 2016).  Hurricanes have 

been shown to affect forest woody plant species and their distribution (Middleton, 2009).  Taxodium 

distichum L.  Rich, (bald cypress) and Nyssa aquatic L., (water tupelo) tended to thrive in hurricane-

impacted forests, because these species are less susceptible to wind damage than species such as Acer 

rubrum L., (red maple), Quercus lyrata (Walter), (overcup oak) and Quercus nigra (Aiton) Ashe, (water 
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oak) (Middleton, 2009).  The satellite data for Climate Engine and the NDVI would likely not be able to 

distinguish these types of changes if they are occurring in Carolina Bays.  

Additionally, rainfall varied with each individual hurricane event and was unrelated to the 

impacts studied.  However, future studies may find that rainfall amounts influence additional factors in 

Carolina Bays such as species composition and water quality. 

The size and makeup of Carolina Bays may also affect the ability of the Climate Engine data to 

detect changes in their vegetative status.  Due to the fact that Carolina Bays are often either smaller or 

shallow wetlands, the resolution of the photographic images may not be able to pick up the vegetation 

changes. Landsat images have a 30 x 30 m pixel size, so if the sites selected were smaller than the pixel 

size, the NDVI value might not be able to pick up vegetative changes.  Additionally, the NDVI values may 

not include other land uses that were on a scale smaller than the Landsat resolution.    

One of the sources of error in this study was that Climate Engine’s effectiveness may have been 

impaired by cloud cover during the period when it was most important to observe the changes in 

Carolina Bay’s vegetation due to the hurricane events.  During the time period I was trying to analyze, 

cloud cover was present during each event.  When cloud cover occurs, the satellite is unable to collect 

photographic data for NDVI.  This caused an issue with missing data right around the time of the 

hurricane.  This may have led to effects occurring in Carolina Bays that were not able to be picked up or 

observed using Climate Engine.  This not only affected the frequency of images right around the time of 

the hurricane, but it affects the frequency of available images in Climate Engine as a whole.    

Finally, NDVI values may be impacted by seasonal changes in the vegetative cover.  These 

changes could very well occur during the same time period hurricanes occur in Carolina Bays.  

Separating out the change in NDVI due to hurricanes and the change in NDVI due to seasonal changes 

would be an interesting future research area.   

Future research could find more effective ways to analyze this variable.  While in our case, the 

data from Climate Engine proved to be capable of detecting large scale changes to vegetative cover of 

study sites like Carolina Bays, it did not prove to be very sensitive to possible smaller impacts from 

hurricanes.  However, cloud based remote sensing holds great promise for resources managers. Landsat 

images that I used in this study used to cost around $500-$1000 each five to ten years ago. For each site, 

Climate Engine provided approximately 30-40 NDVI values, which are based on 30-40 Landsat images. 

That means that the kind of study I conducted, would have costed $15,000 to $40,000 per site before 
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these images became freely accessible. Processing these kinds of images would have also required large 

amounts of computing time, which in my case was all done on servers hosted by Google. While Climate 

Engine might not have been the best tool to examine the effects of hurricanes on Carolina Bays, it is 

clear that this will be a tool that will continue to become more important for the rapid analyses of large 

remote sensing datasets.     
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Appendix B.  GIS Procedure Log 

Procedure Log For Sara Schager’s Professional Project GIS work Log 

Data: 

Storm.2005185N18273.ibtracs_all_lines.v03r09.shp file 

Storm.2005249N26281.ibtracs_all_lines.v03r09.shp file 

Storm.2005278N27280.ibtracs_all_lines.v03r09.shp file 

Storm.2006161N20275.ibtracs_all_lines.v03r09.shp file 

Storm.2006237N13298.ibtracs_all_lines.v03r09.shp file 

Storm.2007151N18273.ibtracs_all_lines.v03r09.shp file 

Storm.2007251N30288.ibtracs_all_lines.v03r09.shp file 

Storm.2008201N32280.ibtracs_all_lines.v03r09.shp file 

Storm.2008229N18293.ibtracs_all_lines.v03r09.shp file 

Storm.2008241N19303.ibtracs_all_lines.v03r09.shp file 

Storm.2009228N27277.ibtracs_all_lines.v03r09.shp file 

Storm.2009308N11279.ibtracs_all_lines.v03r09.shp file 

Storm.2010222N26277.ibtracs_all_lines.v03r09.shp file 

Storm.2011197N31280.ibtracs_all_lines.v03r09.shp file 

Storm.2011245N27269.ibtracs_all_lines.v03r09.shp file 

Storm.2012140N33283.ibtracs_all_lines.v03r09.shp file 

Storm.2012147N30284.ibtracs_all_lines.v03r09.shp file 

Storm.2012176N26272.ibtracs_all_lines.v03r09.shp file 

Storm.2013157N25273.ibtracs_all_lines.v03r09.shp file 

Storm.2013204N11340.ibtracs_all_lines.v03r09.shp file 

Storm.2014180N32282.ibtracs_all_lines.v03r09.shp file 

Storm.2015126N27281.ibtracs_all_lines.v03r09.shp file 

Storm.2015193N35285.ibtracs_all_lines.v03r09.shp file 

Coordinate System>Data Frame Properties 

WGS_1984_Web_Mercator_Auxiliary_Sphere 

WKID: 3857 Authority: EPSG 
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Projection: Mercator_Auxiliary_Sphere 

False_Easting: 0.0 

False_Northing: 0.0 

Central_Meridian: 0.0 

Standard_Parallel_1: 0.0 

Auxiliary_Sphere_Type: 0.0 

Linear Unit: Meter (1.0) 

  

  

Basemap World Topographic Map>Coordinate System >Data Frame Properties 

WGS_1984_Web_Mercator_Auxiliary_Sphere 

WKID: 3857 Authority: EPSG 

  

Projection: Mercator_Auxiliary_Sphere 

False_Easting: 0.0 

False_Northing: 0.0 

Central_Meridian: 0.0 

Standard_Parallel_1: 0.0 

Auxiliary_Sphere_Type: 0.0 

Linear Unit: Meter (1.0) 

  

To each hurricane line we will need to buffer the line twice…to the right of the line and to the left of 

the line.  To create the buffer layer go to Geoprocessing>Buffer.  Then each hurricane needs to be 

buffered to the right: 

  

An Active X control on this page might be unsafe to interact with other parts of the page.  Do you want 

to allow this interaction?  Yes 

  

And to the left: 

An Active X control on this page might be unsafe to interact with other parts of the page.  Do you want 

to allow this interaction?  Yes 
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Change the colors of both buffers so that they match.  This creates a buffer of each hurricane path that 

is 30 km to the right and 80 km to the left of the hurricane line.  This was the chosen buffer width 

because (LOOK UP STUDY) indicated that the worst winds of a hurricane were seen at 70 km to the east 

or left of the eye of the hurricane (the line shown by the 2005 Cindy layer.  

  

Buffer {2005 Cindy, 2005 Ophelia, 2006 Alberto, 2006 Ernesto, 2007 Barry, 2007 Gabrielle, 2008 

Cristobal, 2008 Hanna, 2008 Fay, 2009 Ida, 2009 Claudette, 2010 Five, 2011 Lee, 2011 Brett, 2012 Beryl, 

2012 Alberto, 2012 Debby, 2013 Andrea, 2013 Dorian, 2014 Arthur, 2015 Ana, 2015 Claudette} 

Input Features: {2005 Cindy, 2005 Ophelia, 2006 Alberto, 2006 Ernesto, 2007 Barry, 2007 Gabrielle, 2008 

Cristobal, 2008 Hanna, 2008 Fay, 2009 Ida, 2009 Claudette, 2010 Five, 2011 Lee, 2011 Brett, 2012 Beryl, 

2012 Alberto, 2012 Debby, 2013 Andrea, 2013 Dorian, 2014 Arthur, 2015 Ana, 2015 Claudette} 

Output Feature Class: {Hurricane Name Year_Buffer} 

Distance: Linear Unit: 100 km 

Side type: Right 

End type: Round 

Method: Planar 

Dissolve Type: All 

  

Buffer {2005 Cindy, 2005 Ophelia, 2006 Alberto, 2006 Ernesto, 2007 Barry, 2007 Gabrielle, 2008 

Cristobal, 2008 Hanna, 2008 Fay, 2009 Ida, 2009 Claudette, 2010 Five, 2011 Lee, 2011 Brett, 2012 Beryl, 

2012 Alberto, 2012 Debby, 2013 Andrea, 2013 Dorian, 2014 Arthur, 2015 Ana, 2015 Claudette} 

Input Features: {2005 Cindy, 2005 Ophelia, 2006 Alberto, 2006 Ernesto, 2007 Barry, 2007 Gabrielle, 2008 

Cristobal, 2008 Hanna, 2008 Fay, 2009 Ida, 2009 Claudette, 2010 Five, 2011 Lee, 2011 Brett, 2012 Beryl, 

2012 Alberto, 2012 Debby, 2013 Andrea, 2013 Dorian, 2014 Arthur, 2015 Ana, 2015 Claudette} 

Output Feature Class: {Hurricane Name Year_Buffer_left} 

Distance: Linear Unit: 30 km 

Side type: Left 

End type: Round 

Method: Planar 

Dissolve Type: All 
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Create a Map of Each Hurricane with Buffers to enable site selection. 

Example (Hurricane Hanna) for each Hurricane. 

Open New Map 

Blank Map 

Add Data>Add Basemap>Imagery 

Zoom Scale to 1:4,000,000 

  

File>Add Data>Select Correct Shapefile 

  

Buffer Storm track 30 Km to the left. 

  

Select Geoprocessing>Buffer 

  

An Active X control on this page might be unsafe to interact with other parts of the page.  Do you want 

to allow this interaction?  Yes 

  

Input Features: Storm.2008241N19303.ibtracs_all_lines.v03r09 

Output Feature Class: C:\Users\Schager\Desktop\EA 665\GIS Data\GIS Individual Hurricanes with 

buffers\Hanna_Buffer_L30.shp 

  

Distance: Select Linear Unit 

           30 km 

Side Type: Left 

End Type: Round 

Method:Planar 

Dissolve Type: All 

  

Select OK 

  

Buffer Storm track 30 Km to the right. 

  

Select Geoprocessing>Buffer 
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An Active X control on this page might be unsafe to interact with other parts of the page.  Do you want 

to allow this interaction?  Yes 

  

Input Features: Storm.2008241N19303.ibtracs_all_lines.v03r09 

Output Feature Class: C:\Users\Schager\Desktop\EA 665\GIS Data\GIS Individual Hurricanes with 

buffers\Hanna_2008_Buffer_R30.shp 

  

Distance: Select Linear Unit 

           30 km 

Side Type: Right 

End Type: Round 

Method:Planar 

Dissolve Type: All 

  

Buffer the Storm track 70 km to the right. 

  

Select Geoprocessing>Buffer 

  

An Active X control on this page might be unsafe to interact with other parts of the page.  Do you want 

to allow this interaction?  Yes 

  

Input Features: Storm.2008241N19303.ibtracs_all_lines.v03r09 

Output Feature Class: C:\Users\Schager\Desktop\EA 665\GIS Data\GIS Individual Hurricanes with 

buffers\Hanna_2008_Buffer_R70.shp 

  

Distance: Select Linear Unit 

           70 km 

Side Type: Right 

End Type: Round 

Method:Planar 

Dissolve Type: All 
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Buffer the Storm track 100 km to the right. 

  

Select Geoprocessing>Buffer 

  

An Active X control on this page might be unsafe to interact with other parts of the page.  Do you want 

to allow this interaction?  Yes 

  

Input Features: Storm.2008241N19303.ibtracs_all_lines.v03r09 

Output Feature Class: C:\Users\Schager\Desktop\EA 665\GIS Data\GIS Individual Hurricanes with 

buffers\Hanna_2008_Buffer_R100.shp 

  

Distance: Select Linear Unit 

           100 km 

Side Type: Right 

End Type: Round 

Method:Planar 

Dissolve Type: All 

  

Clip Hurricane Buffer Right 100. 

Geoprocessing<Clip 

Input Feature Class: (Hurricane Name)_Buffer_R100 

Clip Feature: (Hurricane Name)_Buffer_L30 

Output Feature Class: Clipped_(Hurricane Name)_Buffer_R100 

  

Erase Clip 

Geoprocessing<ArcToolBox<Overlay<Erase 

Input Feature Class: (Hurricane Name)_Buffer_R100 

Erase Features: Clipped_(Hurricane Name)_Buffer_R100 

Output Feature Class: Good_(Hurricane Name)_2013_Buffer_R100 

  

Change Transparency of Buffers so they can be seen through to locate Carolina Bay study sites. 



60 
 
 

  

Right click on Data Layer>Layer Properties>Display>Transparent 50% 

Apply>OK 

  

File>Save As>Desktop>EA665>Hanna Buffers 

Repeat for Hurricane Cindy, Hurricane Ernesto, Hurricane Hanna, Hurricane Beryl, Hurricane Andrea, 

Hurricane Anna. 

  

Select sites on path and label each site with a point marker. 

  

NDVI Input Data 

  

Web address:  http://clim-engine.appspot.com/ 

Choose Figure/Data 

Time series Calculation: Daily Data 

                                        One Variable Analysis 

Region: Points 

           Points: Input Latitude and Longitude Data 

Variable 1: 

Type: Remote Sensing 

Dataset: Landsat 4/5/7/8 Surface Reflectance 

Variable: NDVI (Vegetation Index) 

Computation Resolution (Scale): 30 M 

Time Period: 

Season: Custom Date Range 

Start Date: 3 months before hurricane date 

End Date: 9 months after hurricane date 
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Appendix C.  Graphs of NDVI data for Study Sites 1-32. 

Figure 1.  Site 1’s NDVI Graph.

  



62 
 
 

Figure 2.  Site 2’s NDVI Graph. 
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Figure 3.  Site 3’s NDVI Graph.
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Figure 4:  Site 4’s NDVI Graph. 
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Figure 5:  Site 5’s NDVI graph. 
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Figure 6:  Site 6’s NDVI Graph. 
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Figure 7: Site 7’s NDVI Graph. 
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Figure 8: Site 8’s NDVI Graph. 
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Figure 9: Site 9’s NDVI Graph. 
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Figure 10:  Site 10’s NDVI Graph. 

  



71 
 
 

Figure 11: Site 11’s NDVI Graph. 
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Figure 12: Site 12’s NDVI Graph. 
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Figure 13: Site 13’s NDVI Graph. 
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Figure 14:  Site 14’s NDVI Graph. 
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Figure 15: Site 15’s NDVI Graph. 
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Figure 16: Site 16’s NDVI Graph. 
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Figure 17:  Site 17’s NDVI Graph. 
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Figure 18: Site 18’s NDVI Graph. 
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Figure 19: Site 19’s NDVI Graph. 
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Figure 20: Site 20’s NDVI Graph. 
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Figure 21: Site 21’s NDVI Graph. 
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Figure 22: Site 22’s NDVI Graph. 
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Figure 23: Site 23’s NDVI Graph. 
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Figure 24: Site 24’s NDVI Graph. 
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Figure 25:  Site 25’s NDVI Graph. 
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Figure 26: Site 26’s NDVI Graph. 
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Figure 27: Site 27’s NDVI Graph. 
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Figure 28: Site 28’s NDVI Graph. 
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Figure 29: Site 29’s NDVI Graph. 
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Figure 30: Site 30’s NDVI Graph. 
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Figure 31: Site 31’s NDVI Graph. 
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Figure 32: Site 32’s NDVI Graph. 
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Appendix D.  Study site tables for each hurricane 

Table 19.  Hurricane Alberto study site’s Information. 

Study Site Number Location Relative to the 
Hurricane Path 

Latitude Longitude 

1 Left, 30 km 78.04145583 35.603645 

2 Hurricane Path 78.72466328 35.05632414 

3 Right, 30 km 78.63452014 34.78897775 

4 Right, 70 km 78.30592858 34.50626369 

5 Right 100 km 77.69667761 34.439641 

 

Table 20.  Hurricane Andrea (NOAA Storm Number 2013157N25273) Information 

Study Site Number Location Relative to the 
Hurricane Path 

Latitude Longitude 

6 Left, 30 km 79.47419044 34.71897461 

7 Hurricane Path 78.75038758 35.06919808 

8 Right, 30 km 78.47419044 34.88518086 

9 Right, 70 km 78.29771211 34.48733361 

10 Right 100 km 77.60520019 34.76834981 
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Table 21.  Hurricane Ana (NOAA Storm Number 2015126N27281) Information 

Study Site Number Location Relative to the 
Hurricane Path 

Latitude Longitude 

11 Left, 30 km 78.70224367 34.96015269 

12 Hurricane Path 78.53054175 34.63776081 

13 Right, 30 km 78.25330819 34.47487822 

14 Right, 70 km 77.69667761 34.439641 

15 Right, 100 km 77.28974867 34.66298689 

 

Table 22.  Hurricane Beryl (NOAA Storm Number 2012147N30284) Information 

Study Site Number Location Relative to the 
Hurricane Path 

Latitude Longitude 

16 Left, 30 km 78.03874308 34.38447267 

17 Hurricane Path 77.98347103 34.11316514 

 

Table 23.  Hurricane Ernesto (NOAA Storm Number 2006237N13298) Information 

Study Site Number Location Relative to the 
Hurricane Path 

Latitude Longitude 

18 Left, 30 km 78.31954331 34.55936786 

19 Hurricane Path 77.89217756 34.85939894 

20 Right, 30 km 77.45295383 35.18133225 

21 Right, 70 km 76.77272397 35.78512139 

22 Right 100 km 76.44699664 35.77619694 

 

 

 

 



95 
 
 

Table 24. Hurricane Hanna (NOAA Storm Number 2008241N19303) Information 

Study Site Number Location Relative to the 
Hurricane Path 

Latitude Longitude 

23 Left, 30 km 78.682166 34.91747786 

24 Hurricane Path 78.32670989 34.99881553 

25 Right, 30 km 77.92222292 35.20818911 

26 Right, 70 km 77.60520019 34.76834981 

27 Right, 100 km 77.09840533 35.27193056 

 

Table 25.  Hurricane Fran (NOAA Storm Number 1996237N14339) Information  

Study Site Number Location Relative to the 
Hurricane Path 

Latitude Longitude 

28 Left, 30 km 78.891257 34.897009 

29 Hurricane Path 78.453415 34.732093 

30 Right, 30 km 78.37672 35.258385 

31 Right, 70 km 78.031679 35.786102 

32 Right, 100 km 77.6159 35.422046 

 




